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Introduction 

Purpose of this Cookbook 

This cookbook is intended to help hydrologists to begin using GIS as 

a tool as quickly as possible.  It is written based on the assumptions 

that it is best to learn by doing and that students’ time should not be 

consumed by having to recall or look up minute details about how to 

run computer programs.  In this cookbook,  “recipes” are presented 

for various hydrologic “casseroles” that can be cooked in ArcView 

GIS.  The recipes give step-by-step directions for the tedious 

processes of loading data in a GIS (Geographic Information System), 

manipulating those data and running some other, related computer 

programs.  Hopefully, these pages will help students get to the “fun 

stuff” painlessly. 

Cookbook Format 

This cookbook describes how to use numerous programs.  Rather 

than trying to present every step in every recipe, the author has 

chosen to present recipes as simple step by step procedures, 

assuming the user already knows how each program is run.  

Because the author is kind, he has also provided more detailed 

instructions on how to run each of the programs as Appendixes in 

the back of this cookbook.   

Each recipe begins with a short description of the task at hand and 

a list of the ingredients (programs and data) needed to accomplish 

the task.  Next, the steps to cook the casserole are presented.  

Finally, an example or some examples of output from the task are 

presented.  Of course, there are likely several ways to do every task 

outlined in this report.  But try to follow the steps in this report at 
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least the first time you try each recipe, since the various recipes 

illustrate particular features or functions of ArcView or the 

computer programs used in conjunction with ArcView. 

It is essential that everyone read Appendix A.  Appendix A 

describes ArcView projects and nomenclature and will help us all 

speak the same language.   

As a further proof of his kindness, the author has assembled the 

programs and some of the data required to cook the recipes given in 

this cookbook.  They are found on several floppy disks.  The 

programs include: 

• the UTMS coordinate transformation program (USGS); 

• the GeoEAS geostatistical software (US EPA); 

• the USStrm for generating statistics based on USGS stream flow 

time series data files (Bartrand, Ohio U); 

• the dlg2shp.ave ArcView Avenue script for converting USGS 

Digital Line Graphs (DLGs) to ArcView shape files (share ware, 

WWW); and 

• the centr.ave ArcView Avenue script for calculating the centroid 

of a polygon in ArcView (share ware, WWW). 

The data include: 

• the Scioto River basin (a polygon theme); 

• the rivers and lakes in the Scioto River basin (a line theme 

derived from USGS DLGs) 

• a table of the names and locations of precipitation and 

temperature gaging stations in and near the Scioto River basin. 
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• data of the political boundaries and population density of  

Cambodia (from the UNEP/GRID data set [WWW] and for use in 

the exercise in Recipe 2). 

A Few Notes Before You Begin 

You will be well served to manage your files and data carefully in 

ArcView.  Before you finish you will have amassed many files which 

will “own” much “real estate” on your computer’s hard drive.  First, 

before you do anything, create a directory on your computer called 

“GIS.”  Then create subdirectories within GIS called “DATA,” 

“UTILITIES, “ UTMS”  and “GeoEAS” with the directory structure 

shown below.   

 

   DATA 

 GIS      UTMS 

   UTILITIES 

      GEOEAS 

If more than one user will be performing these exercises on 

computer, replace the directory name “GIS” with your own name.   

When you have created the directories shown above, copy the file 

geoeas.zip from the diskette to the C:\GIS\UTILITIES\GEOEAS 

directory.  Copy the file UTMS.EXE to the UTMS directory.  Copy 

all the other files the DATA directory.  Your working directory in 

all the exercises is the C:\GIS\DATA directory. 

Have fun and make some good science! 
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Getting to Know View 

Recipe 1:  Reading a Theme and Making a Map 

The first recipe makes a printed map of any country on Earth.  It 

introduces how to get themes into ArcView and how to print your 

results out.  Hopefully you have read Appendix A, so let’s go. 

   Ingredients : 

1. ArcView; and 

2. The World map that comes as ArcView data. 

Steps: 

1. Start a new project.  To do this, start ArcView and choose 

“New Project” from the “File” pull-down menu.  The project 

window appears on the screen.  The words and icons for “View,” 

“Chart,” “Table,” “Layout” and “Script” are on the left side of the 

project window. 

2. Make a new view by choosing the “View” icon from the left side 

of the project window, then click the “New” button on the top of 

the project window.  A View window appears on the screen.  You 

will likely need to move the view window and resize it to get it 

out of the way of the project window and make it large enough to 

see the map you will put in it. 

3. From the “View” entry on the menu bar, select “properties.”  On 

the window that pops up, select decimal degrees as the map 

units and kilometers or miles as the distance units.  Give 

the view the name “World Map.”  
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4. From the button bar, choose the “add theme” button.  It looks 

like a pat of butter with a large + in its middle.  If you can’t tell 

which button is the correct one, look at the bottom of the 

window as you put the mouse over each button.  There should be 

a brief description of each button. 

5. In the window that pops up, select the world map.  The path to 

the world maps is c:\esri\esridata\world and the file name is 

cntry94.shp.  After hitting OK an entry will appear on the left 

side (the legend) of the view window. 

6. To display the world map you have just put into the view, click 

on the small gray box  found at the upper-left hand corner of the 

entry that just appeared in the legend.  The world should appear 

in the view window. 

7. Next, zoom-in on the country you want to isolate.  To zoom, click 

the button that looks like a magnifying glass with a  +  in the 

lens.  After clicking the zoom tool, go to the view window and 

click and hold down the left mouse button at the upper left 

corner where you want to zoom in.  Without letting up the 

mouse button, drag open a rectangle by moving the mouse down 

and to the right.  Let go of the mouse when the box covers the 

region to which you want to zoom. 

8. Select the country you want to isolate.  Click on the select 

button from the tool bar.  It looks like a rectangle with a small 

star in one corner.  Go to the country you want to map and click 

once on it.  It should turn yellow.  You have just “selected” that 

country. 

9. Make the selected country into a shape file by clicking “Theme” 

from the menu bar and choosing “Convert to shapefile” from 
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the pull-down menu.  A window pops up asking for a file name 

for the new shape file.  Specify a new, unique file name for the 

file in the C:\GIS\DATA directory of the computer.  After 

ArcView writes the new shape file, a window pops onto the 

screen asking whether you want to add the new shape file to the 

view.  Answer “no.” 

10. Close the view window containing the world. 

11. Create a new view .  From the project window, click on the 

“View” icon, then click on the “New” button at the top of the 

project window.  A new view window appears on the screen.  

Like before, choose “View” from the menu bar and “Properties” 

from the pull-down menu.  Again, give the view an appropriate 

name (the name of the country you are mapping), make the map 

units decimal degrees and the distance units either kilometers 

or miles. 

12. Click the add theme button (butter pat with a + in the middle) 

and add your newly-created theme to the view.  Click on the 

small gray box in the legend to display the country map you 

created.  At this point, a map of the country could be printed by 

selecting “print” from the “file” pull-down menu.  But we will 

use a layout to make the print. 

13. Create a new layout.  To do this, click once on the “Layout” 

icon on the left side of the project window, then click on the 

“New” button at the top right of the project window.  A new 

window should appear with the title “Layout1” in the title bar. 

14. The button on the far right of the bottom button bar is used next. 

It probably has a small globe in its center.  Click on that button 

and hold it down.  A number of other buttons should appear 

below the button that was clicked.  These buttons allow the user 
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to put a map, a scale bar, a North arrow and other features onto 

the layout.  First, select the button that looks like a 2-D picture 

of a globe.  This button will allow you to show a map (view) on 

the layout.  After clicking the button, move the mouse onto the 

layout window to where you want the upper-left-hand corner of 

the map.  Click and hold down the mouse button and drag 

open a window (down and to the right) enclosing the area 

where you want the map to appear.  Let go and answer the 

questions that pop onto the screen.  Make sure to specify the 

proper view name from which to take the map.  It should be 

something like “View2” or whatever name you gave to the view 

containing the country you are making a map of.  After 

answering all the questions, a map of your country should 

appear on the layout. 

15. Next, add a North arrow.  Click and hold on the button you 

used to put the view onto the layout.  This time, select the 

button that looks like a North arrow.  Move the mouse onto the 

layout to the upper left corner of where you want to draw the 

North arrow.  Click the mouse and hold.  Drag open a rectangle 

within which you want the North arrow.  If you want to change 

the position or size of the North arrow (or anything else on the 

view), select the solid arrow from the button bar, then click on 

the thing you want to change.  After something has been selected 

like this, four black squares appear at the corners of the object.  

The object can now be moved around or resized.  To move the 

object, put the mouse in the center of the selected object.  It 

should look like a four-headed arrow.  When you see the four-

headed arrow, click and hold the mouse down.  Move the mouse 

to move the object. 
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16. Add a scale bar.  To do this, click and hold on the button you 

used in steps 14 and 15.  This time, select the button that looks 

like a scale bar.  Again, put the mouse on the upper left corner of 

the location on the layout where you want the scale bar, click 

and drag open a box in which you want the scale bar.  Answer 

the ensuing questions, making sure to choose the view with the 

country in it as the view from which you are taking the scale.  

The author routinely misses this step.  If you do, the scale bar 

pops up saying “empty scale bar.”  To correct it, select the scale 

bar by clicking on the solid arrow on the button bar, then 

clicking on the scale bar with the mouse.  Next, from the 

“Graphics” pull-down menu (from the menu bar) choose 

“Properties.”  This will give you a second chance at getting the 

properties correct. 

17. Finally, add any text you want to the layout.  Click  the “T” 

button on the button bar, move the mouse to where you 

want the text and click.  A box pops up, into which you type 

the text you want to appear on the layout.  when finished typing, 

click the “OK” button.   

18. To change text properties, select “Symbols Window” from the 

“Windows” pull-down menu on the menu bar.  A window pops 

onto the screen.  That window will allow you to change the color, 

size and appearance of almost everything on the screen.  Objects 

must be selected before they can be modified.  To select objects, 

click on the solid arrow on the lower button bar, then click on 

the object that you want to modify.  To change text font or size, 

select text, then click on the button in the symbols that has ABC 

on it and select the font and size you want.  The color, line 

thickness and other properties of the text can also be changed. 
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19. Print the map using the “Print” command in the “File” pull-down 

menu. 

Figure 1 (on the following page) shows a map of Cameroon created 

following the steps above.
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Recipe 2:  Creating a Population Density Map 

The next recipe demonstrates how ArcView can display the 

attributes of a data set.  In this recipe you will use data from a 

UNEP (United Nations Environmental Programme) GRID data set 

which was downloaded from the WWW and converted to an 

ArcView shape file.  You should have copied the files cambodia.shp, 

cambodia.shx and combodia.dbf from the diskette accompanying this 

report to the C:\GIS\DATA directory. 

Ingredients: 

1. ArcView; and 

2. The data files cambodia.shp, cambodia.shx and cambodia.dbf. 

Steps: 

1. Start a new project. 

2. Create a new view.  Make the properties: map units of decimal 

degrees, distance units of kilometers and name “Cambodia.” 

3. Add the theme Cambodia.shp. 

4. Display the map of Cambodia by clicking on the small gray 

box  found at the upper-left hand corner of the entry that just 

appeared in the legend.  The districts of Cambodia should 

appear in the view window.  The political divisions in Cambodia 

are provinces, districts, communes and villages.  The map in the 

view shows Cambodia’s districts. It could be modified to show 

provinces. 
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5. Double-click on the word “cambodia.shp” in the legend to 

bring up the legend editor window. 

6. Change the type of display of the Cambodia districts 

theme.  To do this, find the line in the legend editor that gives 

legend type.  It should have the words “Unique Value” in the 

white box given legend type.  Change this Graduated Color” by 

clicking on the downward arrow at the right of the box and 

clicking on “Graduated Color.”  The entries for the legend 

(shown below in the legend editor) should change. 

7. Select population as the value that will show up on the map.  

To do this, go to the “Classification Field” entry on the legend 

editor, click on the down-arrow at the right of that entry and 

scroll down to the field called “popest95.”  Now the color of each 

district is determined by the 1995 population estimate. 

8. Convert population to population density.  To accomplish 

this, go to the box in the legend editor that says “Normalize by” 

and scroll down to the entry “Area” and click on it.  Now the 

color of each district will correspond to the 1995 population 

estimate divided by the district’s area. 

9. Change the classification.  You probably want to change the 

way the data are classified.  To do this, click on the “Classify” 

button to the right of the legend editor.  A window pops up.  In 

this window, change the number of intervals to some number 

larger than 5 (15 looks pretty good here).  Also, replace “Natural 

Breaks” in the box at the top of the window to “Equal Areas.”  

Finally, at the bottom, change the classification display from 

d.ddd (or whatever it currently is) to something like dd,dddd.  

This will make the numbers shown in the legend easier to see 

and interpret.  Click OK when all these steps are complete. 
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10. Change the colors of the districts.  This is the step that the 

artistic among you have been waiting for.  At the bottom of the 

legend editor (which should still be on the screen) is the color 

scheme box.  It likely has the words “Red Monochromatic” in it.  

Click on the down-arrow to the right of the box and scroll to the 

color scheme you want.  There are no wrong answers here.  

When you are happy with the color scheme, click the “Apply” 

button in the lower right corner of the legend editor window. 

11. Create a new Layout (with the “New” button in the upper right 

corner of the project window). 

12. Add the map of Cambodia to the layout via the button that 

looks like a 2-D picture of a globe.  After clicking the button, 

move the mouse onto the layout window to where you want the 

upper-left-hand corner of the map.  Click and hold down the 

mouse button and drag open a window (down and to the right) 

enclosing the area where you want the map to appear.  Let go 

and answer the questions that pop onto the screen. 

13. Add a North arrow. 

14. Add a scale bar. 

15. Finally, add any text you want to the layout. 

16. Print the map 

Your resulting layout should look something like the one shown in 

Figure 2. 
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Showing Gage Locations in ArcView 

Recipe 3:   Creating a Table of Gage Locations 

The following steps yield a table of stream flow gauging station 

locations in the UTM (Universal Transverse Mercator) projection.  

Following these steps yields a table like Table 1.  The location and 

names of the gaging stations can be found at the top of USGS on-line 

stream flow data files, which can be found the world wide web 

(WWW) at the URL http://usgs.gov ... 

Ingredients: 

1. USGS stream flow gaging station data files 

2. Coordinate conversion routine UTMS.EXE (DOS executable) 

3. ArcView  

Steps: 

1. Download historic stream flow data for each gaging station in 

the Scioto Basin. 

2. Read  and record the geographic coordinates (in 

latitude/longitude, degrees, minutes, seconds) from the header 

information at the top of the historic stream flow record data 

file. 

3. Run the UTMS program to convert latitude and longitude to 

Universal Transverse Mercator (UTM) coordinates.  See 

Appendix B for a detailed description of using UTMS). 
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4. Start ArcView and create a new project called “Scioto.apr.”  

see Appendix A and recipe 1 for a detailed description of 

ArcView projects and how to make new projects. 

5. Create a new table by activating the “Tables” icon on the 

project window and clicking the “New” button at the top of the 

project window.  A table appears on the screen. 

6. Change the table name to “streamg.dbf” by selecting 

“Properties” from the Table pull-down on the menu bar and 

editing the “Name” field in the box that pops up. Click “OK” 

when finished. 

7. Start editing the table by choosing “Start Editing” from the 

“Table” pull-down menu. 

8. Add a field for the station name by  selecting “Add Field” from 

the “edit” pull-down menu.  Fields are columns of data and 

Records are rows of data.  Give the field the name “Station,” set 

the data type to “string” and set the width equal to 24 

characters.  Click “OK” 

9. Add the fields “Easting” and “Northing” in the same way the 

“Station field was added.  Select “Number” for their data type 

and 1 for the number of decimal places.  When you finish there 

should be three columns on your table with the labels “station,” 

“Easting” and “Northing.” 

10. Select “Add Record” from the “Edit” pull-down menu.  A 

row appears on your table. 

11. Enter the data into the table as follows.  On the tool bar, there 

are three buttons to the far right.  Click the middle button (the 

“Change cell values” button). Next, click in the “station” field 
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and type the name of the first gaging station.  Tab to the 

“Easting” field and type the Easting value from the output of 

the UTMS program (step 2).  Likewise, tab to the “Northing” and 

enter the appropriate Northing.  Repeat steps 9 and 10 until 

you have entered all the gaging station names and coordinates. 

12. Save your edits and stop editing by selecting “Stop Editing” 

from the “Edit” pull-down menu and answering “Yes” when 

ArcView asks whether you want to save your edits. 

Your table should look like the one found below in Table 1. 
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Recipe 4:  Adding the Event Theme to a View 

Ingredients: 

1. ArcView 

2. A database file (streamg.dbf) of stream flow gaging station 

names and coordinates (from Recipe 3). 

Steps: 

Note: you don’t need to do perform the first four steps if you are 

continuing directly from Recipe 3.  The first four steps are for 

adding event themes for tables that were created outside ArcView 

and are not currently part of your project. 

1. Activate the project window by clicking on the title bar. 

2. Activate “Tables” by clicking on the Table icon on the left side 

of the project window. 

3. Select the “Add” button at the top of the project window. 

4. Navigate to the directory where you database table is and 

select the file you wish to add.  Note that the file must have a 

dBase format and must have the extension “.dbf”.  A table with 

columns of numbers and field headings should appear on the 

screen.  Close the table window. 

5. Create a new view by activating the project window and 

double-clicking the “View” icon.  A new view window appears on 

your screen.  You can move the view and resize it in the usual 

fashion.  For now, don’t block the project window with the view. 
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6. Set the view properties by choosing “properties” from the 

“View” pull-down menu.  Give the view the same “Scioto Basin 

Streams,” set the map units to meters (since the you are using 

the UTM projection) and set the distance units to kilometers.  

Click “OK.”  The title on the title bar of your view window 

should change. 

7. Add the event theme by selecting “Add Event Theme” from the 

“View” pull-down menu.  Specify “Easting” as the x-coordinate 

and “Northing” as the y-coordinate then click “OK.”  An entry 

with the name “Streamg.dbf” and a colored marker appears in 

the legend at the left of your view window. 

8. Display the theme by clicking on the small gray box in the 

upper left corner of the legend entry for streamg.dbf.  Markers 

of stream gage locations appear in the view. 

9. Make the stream gage theme active by clicking on the entry 

for the theme in the legend.  The entry for the stream gage 

theme will appear shaded if it is selected. 

10. Identify a gaging station by clicking the “information” button 

on the button bar then clicking directly on one of the markers in 

the view.  A table giving the gaging station name and 

coordinates should appear.  The information button is marked 

with an “i” in a black circle.   Close the query window once you 

have identified several gages.  This step will not work until the 

stream gage theme is active. 
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Recipe 5:  Making a Map Showing Gage Locations 

In this recipe, the ArcView Layouts function is used to generate a 

map of the stream flow gaging stations in the Scioto River basin 

suitable for putting in a report.   

Ingredients: 

1. ArcView 

2. Streamg.dbf (the stream flow gaging station event theme from 

Recipe 4) 

3. Scioto_Basin.shp (a polygon theme (shape file) of the Scioto 

River basin found in the  C:\GIS\DATA folder on your hard 

drive) 

4. Scioto_River.shp (a line theme (shape file) of hydrography in the 

Scioto River found in the C:\GIS\DATA folder on your hard 

drive) 

Steps 

If you have not already done so, copy the data files from the diskette 

accompanying this report to the C:\GIS\DATA directory, as 

described in the introduction section of this report. 

1. Complete all the steps in Recipe 4.  Make sure the Scioto Basin 

view window is the active window.  

2. Add the Scioto Basin polygon theme to the view by either 

selecting “Add Theme” from the View pull-down menu or 

clicking on the add theme button (which looks like a pat of 

butter with a large “+” sign in its center).  After you select to 



 24

“add theme” a window appears in which you must specify the 

appropriate directory and file name.  Navigate to the 

C:\GIS\DATA directory and select the file Scioto_Basin.shp.  A 

new entry appears in the theme legend in your Scioto Basin 

view window. 

3. Display the basin by clicking on the small gray box in the 

upper left corner of the new entry.  The basin should appear in 

your window.  The basin will likely not all fit within the window.  

To change what is in the window, click the “zoom to the extent of 

all themes” button that looks like a stack of papers.  The whole 

basin should now be in the view. 

4. Change the order of the themes by clicking on the 

“Scioto_basin.shp” theme without letting up the mouse button 

and pulling the legend entry below the stream flow gaging 

station theme.  This should move the “Scioto_basin.shp” entry 

below the Streamg.dbf” entry and your gaging stations should 

now be visible in the view. 

5. Edit the Basin’s properties by selecting “Properties” from the 

“Theme” pull-down menu.  Change the theme name from 

“Scioto_basin.shp” to “Basin Boundary.”  Click “OK” 

6. Change the way the basin is displayed.  Double click on the 

legend entry for “Basin boundary.”  Don’t click on the check-

marked box the controls whether or not the theme is displayed.  

A legend editor window should appear on your screen.  A 

diagram of the legend editor (with the various parts labeled) is 

found in Appendix A.  Double click on the symbol for the 

boundary.  The symbols window appears.  A diagram of the 

symbol window is found in Appendix A.  Click the color palette 

button and give the “no color” to the basin.  Now only the basin 
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boundary will appear in the view.  Also, change the outline 

thickness from 0.1 to 1 (using the window at the bottom of the 

symbol window).  After changing the color and line size of the 

basin, close the symbol window and click the “Apply” button at 

the bottom right of the legend editor window. 

7. Change the way the rivers are displayed by double clicking 

on the legend entry for the rivers and following a procedure 

similar to that in step 6.  Make the rivers blue and make the line 

size 0.5.  Also, change the name of the theme to “Rivers and 

Streams” choosing properties from the “Theme” pull-down 

menu. 

8. Change the way the stream flow gaging stations are 

displayed by double clicking the stream gages theme in the 

legend of the view and changing the marker shape, size and 

color. 

9. Create a new layout as you have in the past several recipes.  

As before, add the map, a legend, a scale bar and relevant 

text to the layout and print it. 

The result should look like Figure 3. 
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Importing and Using GeoEAS data in ArcView 

Recipe 6:  Getting GeoEAS output into ArcView 

Appendix C gives a blow-by-blow account of how to run GeoEAS.  

For this recipe, the output from GeoEAS is used as input to 

ArcView.  Before attempting the steps below, run GeoEAS to 

produce a file named “stream.grd” contianing Kriged values for 

stream flow water equivalent depth over the Scioto basin.  Note that 

the grid used in GeoEAS must cover the entire basin and that 

stream flow water equivalent depths are assigned to the centroid of 

the area which drains to each stream gage.  

The  GeoEAS output file stream.grd is in ASCII format and consisits 

of header lines followed by columns of Eastings, Northings, stream 

flow water equivalent depths and Kriging errors.  ArcView requires 

a dBase IV format file whose contents are column labels (Easting, 

Northing, Stream flow and Error) and columns of data.  The first 

several steps in Recipe 6 tell how to convert the ASCII GeoEAS 

output to dBase format using the Excel spreadsheet program. 

Ingredients: 

1. GeoEAS 

2. Microsoft Excel 

3. GeoEAS output file stream.grd 

4. ArcView 
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Steps: 

1. Open the file stream.grd in Microsoft Excel.  When Excel asks 

what type of delimiters to use in importing the file, select spaces 

(not tabs). 

2. Remove all rows except the four columns of data giving 

Easting, Northing, Stream Flow Water Equivalent Depth and 

Kriging Error.  You may also need to remove the first column of 

data, depending on how you opened the file. 

3. Add the column labels: “Easting,” “Northing,” “Stream” and 

“Error” in a row immediately above the columns of data.  To do 

this, open a new row above the columns of data and type the 

appropriate names in the cells above the data. 

4. Change the number formats of the Easting and Northing 

columns so that two decimal places are shown and change the 

formats of the other two columns so that three decimal places 

are shown. 

5. Select “Save As” from the File pull-down menu and save the 

file as a dBase IV data base file.  The file should have a name 

like stream.dbf and should be saved in the C:\GIS\DATA 

directory.  The “.dbf” extension must be used.  Exit Excel when 

finished. 

6. Make a new project called stream.apr in ArcView. 

7. Add the table “stream.dbf” to the project by clicking on the 

“Tables” icon in the project window and clicking the “Add” 

button at the top of the project window. 
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8. Make a new view called “Kriged Stream flow Water Equivalent 

Depth.” 

9. Add the theme “Scioto_basin.shp” to the view. 

10. Add an event theme by selecting “Add Event Theme” from the 

View pull-down menu.  Add the theme “stream.dbf” that you 

created in step 5 (in Microsoft Excel). 

11. Display the theme by clicking on the small gray box in the 

legend entry.  The theme should appear as a grid of points 

covering the entire Scioto River basin. 

12. Change the theme’s display by double-clicking the 

“stream.dbf” entry in the view legend, changing “unique value” 

to “graduated color” and choosing a color scheme.  Click the 

“Apply” button on the lower right corner of the legend editor. 

A layout showing the resulting image is found in Figure 4 
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Recipe 7:  Converting the Event Theme to a Grid 

We’re nearly to some “real hydrology” in ArcView.  But first, the 

vector-format event theme from Recipe 6 must be converted to a 

raster-format grid theme.  In ArcView, raster themes are called 

grids.  Each grid you create lives in a folder on your hard drive.  To 

work with grid themes, the spatial analyst extensions must be 

loaded in ArcView.  This recipe should be “cooked” immediately 

after Recipe 6. 

Ingredients: 

1. ArcView with the spatial analyst extensions 

2. The file “Stream.grd” used in Recipe 6 

Steps: 

1. Make sure the spatial analyst extension is turned on by 

clicking on the project window title bar (to activate the project 

window), selecting “Extensions” from the “File” pull-down menu 

and making certain the “Spatial Analyst” box is checked.  If it 

isn’t, check it by clicking it with your mouse.  Also, make certain 

the working directory is set to C:\GIS\DATA.  Use the “File” 

pull-down menu and the “Set Working Directory” entry to do 

this. 

2. Make certain the “stream.dbf” theme is active in the legend 

of the view by clicking it.  An outline should appeararound the  

theme if it is active.   

3. Select “Interpolate” from the Analysis pull-down menu. 
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4. Answer the questions that appear by selecting stream as the 

field to interpolate and using a spline interpolation with a 

tension of 0.1.  500 m is a suitable size for grid cells.  After you 

click “OK, ”a new theme appears showing contours of stream 

flow water equivalent depth. 

5. Add the theme “Scioto_basin.shp” to the view. 

6. Make the interpolation surface into a grid.  Select “Convert 

to grid” from the “Theme” pull-down menu and specify the name 

“Stream” for the grid name and the directory C:\GIS\DATA for 

the directory.  There is debate among the current civil 

engineering graduate students about the necessity of this step.  

Select a cell size of 500 m and make the extent of the grid the 

same as Scioto_basin.shp. 

7. Convert the Scioto_basin theme to a grid by activating the 

theme (clicking it) and selecting “convert to grid” from the 

“theme” pull-down menu.  Give the new grid the name “basin” 

and place it in theC:\GIS\DATA directory.  Choose the same 

cell size and grid extent as for the Streams grid. 

8. Exit or minimize ArcView and look at the C:\GIS\DATA 

directory using the Windows Explorer (File Manager).  Notice 

that there are two new directories called “Stream” and “Basin” 

in the directory.   
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Recipe 8:  Map Algebra 

The final recipe in this report demonstrates use of map algebra 

functions of ArcView.  This is officially the “fun stuff.”  The result is 

a good looking map.  Start this recipe with a completely new 

project, so you can learn how to add an exisitng grid theme to a 

project. 

Ingredients: 

1. ArcView with the spatial analyst extensions 

2. Scioto_Basin.shp 

3. The “Streams” grid from Recipe 7 

4. The “Basin” grid from Recipe 7 

Steps:  

1. Make a new project called “streams.apr” and make a new grid 

called “Scioto Basin Streamflow” with map units of meters and 

distance units of kilometers. 

2. Add the Basin grid theme and the streams grid theme you 

created in Recipe 7.  This is done by clicking the add theme 

(butter pat with a +) button, then, for the data type (in the lower-

left corner of the box that appears) select “grid data source.”  

The data type is likely “Feature data source” when the window 

first pops up.  Navigate to the C:\GIS\DATA directory and you 

should see the two grid themes you want.  Highlight them both 

(click one of them, then hold the shift key and click the other) 

and hit the “OK” button. 
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3. Add the Scioto_basin.shp theme, too.  Note that its data type 

is “Feature data source.”  Move the Scioto_basin.shp theme 

above the other two themes and display all the themes 

4. Select “Map Calculator” from the “Analysis” pull-down 

menu.  There is a list of grid themes at the upper-left of the 

calculator that appears and some operators next to them.  

Double click on the “Streams” grid.  Single-click the 

multiplication operator (*) and then double-click the “Basin” 

grid.  Finally, click the “Evaluate” button at the bottom of the 

calculator.  A new grid appears in your view.  Each attribute of 

each cell in the new grid is the product of the attributes of the 

cells from the basin and streams grids.  In the basin grid, any 

cell lying inside the basin has the attribute “1” and any cell 

outside the grid has the attribute “0.”  As you see, mutiplying the 

two grids together eliminated all points outside the basin.  

Convert the theme to a grid and give it a new name. 

5. Double click the new theme to bring up the legend editor.  

Select “Graduated color” as the legend type and edit the legend 

to eliminate the black region surrounding the basin and to make 

more sensible intervals.  Note that you can specify intervals for 

the various colors simply by typing the intervals you want.  

Experiment with the “Classify” button, too. 

6. Turn of all themes but the new theme and make a layout 

showing the streamflow water equivalent depth in the Scioto 

River basin.  It should look similar to that of Figure 5. 
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Recipe 9:  Importing an ArcInfo Export File 

Arc/Info export files can be easily imported into Arcview.  The 

import files can be spotted by their file type.  Some examples of the 

file extensions are .e00.  These files can be found on the Internet.  

After downloading an export file follow these following steps to 

import into Arcview. 

Ingredients: 

1 ArcView 

2 Import 71 

Steps:  

1 Open Import 71.  The program will be in your ESRI Program 

Folder. 

2 Either type in the name of the file you want to import (e.g. 

sample.e00) or click the Browse button to search for the file. 

3 Enter the directory and folder you would like to save this 

imported file under.  Most likely you will prefer the same 

directory as the project you have already started.  Name the 

folder something simple that will be easy to remember what it 

is.   

4 Open a project in Arcview in which you would like to view 

this imported file in. 

5 In a view, add a theme.  Select the directory in which you saved 

the import file.  This file will actually be a folder.  Once clicked 

the folder will open and the themes in the folder will be 
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exposed.  Select the theme you want or all of the themes.  These 

themes will be added to the current view. 

6 You can now see the theme. 
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Recipe 10: Digitization of a Lake from a DLG 

Arcview along with dlg2shp avenue script can assist you in 

digitization of a lake.  One problem with the Avenue script is that it 

only forces closure on 1 line at a time. The lake outline is most 

generally not 1 line.  Thus you will get the amount of shapes as 

there is lines.  Parts of these shapes may have to be flipped over the 

line to make the lake correct. 

Ingredients: 

1 Arcview 

2 dlg2shp avenue script 

3 cvtplply avenue script 

Steps:  

1.  First obtain the DLGs you need and proceed to correct them if 

needed.  See chapter on correcting DLGs. 

2.  Bring the DLGs into Arcview as described in the chapter on 

DLGs. 

3.  Open a new script from the Project window. 

4.  Select Load Text File… from the Script pulldown menu.  Go to 

c:\esri\av_gis30\arcview\samples\scripts\ directory.  Select 

cvtplply.ave. 

5.  Now to Compile the script.  Select Compile from the Script 

pulldown menu.  After the script is compiled you can run the 

script on the DLG theme 
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6.  In the View select the theme you want to digitize.  Then 

select the script box (which should still be open from before).  

Select Run from the Script pulldown menu. 

7.  Once the script is running it will ask for a name of a file to 

output to in a Output Shape File box.  Type in a name that is 

appropriate. 

8.  Then the script will ask you to force closure.  Click Yes.  The 

script file then will go to work.  After it is done it will tell you 

how many shapes it converted  It will then ask you if you want it 

to add it to the view.  Click Yes.  Then it will ask you which view 

to add it to.  Click the one you want and Click OK.  The theme is 

then added to the view. 

9.  Now that you are started it may look like that you have created 

a mess.  Its true.  The next step is to clean the mess up.  You may 

notice that the shapes created by the script outline the edge of 

the lake, but they only go part way and then a straight line back. 

(see figure). The edge of the lake is made up of more than one 

line.  The avenues script forces each line closed.  To continue to 

digitize the lake you have to follow some steps.  When a shape is 

on the opposite side of the line of what you want it to be, you 

have to flip it over the line.  If a shape is split like in the figure 

you only want to flip part of the shape over the line.  Each 

polygon has to be fixed one at a time. 

 

 

 

 

   Lake Edge    
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10. To correct the problem, first highlight the lake shape file 

theme.  Then click on Start Editing under the Theme pulldown 

menu. 

11. Click on the draw polygon icon.  This icon is on a pulldown 

icon located directly to the right of the Text icon that looks like 

a T.  The cursor will turn into a cross when the mouse is over the 

active theme. 

12. Draw a polygon that covers the polygon that needs flipped over 

the line.  Continue the polygon into where the lake is. 

13. Select the two polygons, with the select features box, that are 

on top of one another and click on Intersect Features under the 

Edit pulldown menu. 

14. What is left is to subtract a polygon from the polygon you 

just created.  Draw another polygon over the section you want 

to subtract and then select both items with the select features 

box.  Then click on the Subtract Features under the Edit 

pulldown menu. 
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Recipe 11:  Delineating a Watershed 

One of the most important things to do in any environmental or 

water resources project is to delineate the watershed to see what 

land, industry, and geology is within the watershed that flows 

through your project.  This recipe will help you to do this. 

Ingredients: 

1 Arcview 

2 Dlg2shp.ave avenue script 

Steps:  

1 First obtain the DLGs you need and proceed to correct 

them if needed.  See chapter on correcting DLGs.  You will 

need hydrography and hypsography files for all the area 

surrounding the project. 

2 Bring the DLGs into Arcview as described in the chapter 

on DLGs. 

3 The key is to decide on a point that is immediately 

downstream from the project.  Once this point is found the 

delineation can be started. 

4 Now is the time to draw a polygon that encompasses the 

watershed.  Click on New Theme under the View pulldown 

menu.  Choose polygon.  Then select the Draw polygon icon. 

5 Now viewing the  
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11a. Delineating a Watershed  -Bayes 

 

Things Needed: 
 
- topography for the whole watershed (e.g. USGS 1:24k Hypsography files) 

- stream data for the whole watershed (e.g. USGS 1:24k Hydrography files) 

 

Steps: 

1. A base level, or outlet point, needs to be determined.  This determines the size of the 
watershed.  If the base level is set on a large stream or river, the watershed will be large. 

2. In ArcView, create a new theme for the watershed boundary.  With the view open, select 
New Theme... from the View Toolbar. 

3. A line or polygon can be selected out of the pop-up box.  The best way to do it is to use a 
polygon theme so that the watershed can be done in phases rather than all at once. 

4. The New Theme Window will pop-up so that the new theme can be saved.  Select an 
appropriate place and name to save this theme and press OK. 

5. In the Tool Buttons there will be a rectangle.  Click and hold this button down.  This will 
cause buttons to drop down.  Select the polygon button.  When selected the button will 
appear where the rectangle by itself. 

6. Start drawing the polygon at the base level.  When the cursor is at a point in which a vertex 
is desired, click the left mouse button once. 

7. Continue selecting points by clicking the left mouse button once on the boundary of the 
watershed.  Be careful not to double-click the button. 
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Notes: 

- Always keep in mind how water will flow. 

- The polygon can be drawn left or right.  Go the direction that is most comfortable. 

- Water flows perpendicular to contour lines, so the boundary of the watershed will have to 
be perpendicular to the contour lines. 

- Keep track of the stream network so that the watershed does not over stretch or under 
stretch its boundary.  This can happen easily on ridges that splice. 

- Ridges are generally easy to determine where water will flow, but complex hills can be 
tricky.  Try to visualize the hill in 3D in your mind.  This will help you figure out which way 
water will flow and ultimately where the watershed boundary should lie. 

- The view can be panned, zoomed in, zoomed out, or the last point in which you selected 
can be deleted by clicking and holding the right mouse button and selecting the desired 
action. 

 

Steps (Cont): 

8. Continue until fatigue sets in.  At this time, continue the polygon into the watershed so that 
the polygon will not cut itself and that no part of the theme is outside of the watershed. 

9. When the polygon is acceptable at this phase, double click the left mouse button.  This will 
complete the polygon.  When done select Stop Editing from the Theme Menu. 

10. More polygons can be created at a later time by selecting Start Editing from the Theme 
Menu and then using steps 7-9. 

11. Once another polygon of the watershed is completed it can be unioned with the first 
polygon.  Use the Select Tool Button to select both of the polygons. 

12. Select Union Features from the Edit Menu to union the two polygons.  When finished, 
repeat step 9. 
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Recipe 12: Importing Text Files into an Arcview Shapefile 

This recipe demonstrates how to import text files (*.txt) or other 

ASCII files into Arcview and finally converting it into a shapefile.  

This would be done so that a program that would not ordinarily be 

used with Arcview or data that is not in Arcview format can be 

added into projects and used as a layer with other layers. 

Ingredients: 

1. ArcView 

2. Text file (*.txt) or ASCII files (these files must have fields or in a 

format that has x and y coordinates as well as other attributes.) 

3. Microsoft Excel (95 or higher with dBASE converter)  

Steps:  

1. Open MS Excel and open a file.  Note:  If the file is in 

delimited text format (either separated by commas or tabs) – go 

to step 3.  For “Files of Type”, select “All Files (*.*)”.  Select the 

directory so that you can see the text file that you want to 

import.  Once you have selected the file to open select the 

“Open” button.  The “Text Import Wizard” should pop-up.  

Follow the instruction that the wizard gives to bring the text file 

into Excel. 

2. Format and Save the data in a dBASE file.  Once the file is in 

Excel in columns of x, y, and other fields of attributes correctly, 

add a new row at the top with identifying labels such as Latitude 

and Longitude, or Northing and Easting if the labels are not 

already present.  If columns include numbers select the columns 

and format the cells to number format and select the number of 
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decimal places that satisfies you.  If this is not done, conversion 

to dBase format will round the numbers.   Next select “Save As” 

to save the file as a different type.  In the “Save as Type” menu 

select dbf 4 (dBASE IV) (*.dbf) and type the name and select the 

directory where you need to save this file as. 

*Note the following dBASE file formats 

-The dBASE file formats DBF 2 (dBASE II), DBF 3 (dBASE III), and DBF 4 (dBASE IV) save only the text and 

values as they are displayed in cells of the active worksheet. All cell formatting, page layout settings, graphics, 

objects, and other Microsoft Excel 97 features are lost. The data displayed in the current view of a PivotTable 

are saved; all other PivotTable data are lost. 

-All rows are saved; the following numbers of columns are saved. 

Format   Columns 

DBF 2 (dBASE II)    32 

DBF 3 (dBASE III)  128 

DBF 4 (dBASE IV)  256 

-If a range of cells is named "Database," only that range of cells is converted. If you have added new records 

after naming the database range, you must redefine the range to include the new records before you save the file 

in dBASE format. If a database range is not defined, the list of data in the current region is converted. 

-Text values in the first row of the range are used as dBASE field names, which are limited to 10 characters; 

subsequent characters are truncated. If the first row contains all numbers, automatic field names (N1, N2, and 

so on) are inserted in the converted file. 

-Data types of values in the first row of data in the converted range determine the data types of each field 

(column) of data. If the first row of data contains a blank value for a field, the field is converted as a text field, 

even if subsequent rows contain numbers in that field; the numbers are converted as text.   

-Only data visible in the worksheet cells is saved. Widen the columns in Microsoft Excel, and make sure all the 

data is visible before you save the sheet in dBASE format. 

-If cells contain decimal fractions but are formatted in Microsoft Excel with the General number format, the 

values are rounded to the closest whole number. To preserve numbers to the right of the decimal point, format 

the cells with the Number format, and then specify the number of decimal places you want saved. 
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-If cells in the converted range contain formulas, only the resulting values of formulas are saved, even if the 

sheet display options are set to show formulas in the worksheet cells instead of values. To ensure that the 

formula values are converted correctly, click Options on the Tools menu, click the View tab, and clear the 

Formulas check box. Then make sure that all values are visible before you save the file. If you want to save a 

formula as text, insert an apostrophe (') before the formula. 

3. Adding a Table to an Arcview project.  Open Arcview, and 

open a new project.  Select Table in the project window.  Click 

on the “Add” button.  A window will pop up to ask you what file 

you want to add.  If you have delimited text to add select the 

“Delimited Text (*.txt)” from the “List of File Types” menu, 

select the file, and press “OK”.  Otherwise select dBASE (*.dbf), 

select the file, and press “OK”. 

4. Add Event Theme.  Once the file is in the project as a table.  

Open a view so that the table can be viewed.  In the “View” 

menu, select “Add Event Theme …”.  Select the table. X field, 

and Y field before pressing “OK”.  The table will show up in the 

view.  Select the theme to verify the data. 

5. Convert the Event Theme to a Shapefile.  Make the theme 

active by clicking on the area around the theme in the legend.  

This will make it look like part of the legend ‘pulled out’.  Under 

the “Theme” menu, select “Convert to Shapefile”.  Make sure 

that none of the points are selected or ‘highlighted’.  Select a 

name for the new shapefile in a chosen directory.  Press “OK”.  

The point theme then is converted.  Arcview will ask if the 

theme should be added to the view.  Select yes or no.  Now a 

shapefile is available for analysis and evaluation or for future 

interpolation. 
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Recipe 13: Interpolating Surfaces with Spatial Analyst 

This recipe is to understand the background and usefulness of 

spatial interpolation.  The different interpolation models create 

grids that are useful for the evaluation, analysis, and visualization 

of data and also can be utilized with the map calculation that is 

described in previous recipes.  The result is a good looking map that 

can be used for many applications. 

Ingredients: 

1. ArcView with the spatial analyst extensions. 

2. Point Shapefile in the theme. 

Steps:  

1. Activate the point shapefile in the legend of a view that 

contains the point theme.  

2. Select “Interpolate Grid” from the “Surface” menu.  The 

“Output Grid Specifications” pop up menu will appear.  The grid 

specifications are very important for further analysis.  The 

output grid extent is the overall size and limits to the grid.  

Select the default here for now.  Later it will be valuable to 

select the “Same as ‘another grid’” so that comparison and map 

calculations will be simpler.  The “Grid Size” becomes important 

in further analysis of data.  The grid size is the dimensions of 

each individual cell in the delineation.  Small cell sizes will 

produce high resolution grids that take up more space for 

storage.  The key is to develop a cell size that has an acceptable 

resolution and an acceptable storage size.  Also the smaller the 
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cell size the longer the time will take to interpolate and to 

process the data.  For now use the default values. 

3. Interpolating the Surface.  In the “Interpolate Surface” pop up 

window, the method is selected.  The following are notes on the 

different methods.   

 

-IDW Method 

-Note:  Gives values to each cell in the output grid theme by weighting the value of each 

point by the distance from the point to the cell being analyzed and then averaging the values. 

-Dialog box options 

-Nearest Neighbors - Uses the N nearest points to the cell being analyzed. Type in a value for 

N in the No. of Neighbors type-in box. 

-Fixed Radius - Uses all points within a distance of the cell being analyzed. Type in a value 

for the distance in the Radius type-in box. If the distance units for the view are set, then the 

distance will be in distance units. If the distance units are not set, then the distance will be 

in map units. 

-Power - The exponent of distance used in the calculation. Controls the significance of 

surrounding points on the value given to the cell being analyzed. A higher power results in 

less influence from distant points. 

-Barriers - Used to limit certain points from being used in the calculation of a new value for 

a cell, even if the point is one of the nearest neighbors or within a certain distance. You 

wouldn't want to use an elevation point on one side of a ridge to create an elevation value on 

the other side of the ridge. Barriers can be 

 - No Barriers 

 - <Line Theme> - Sets the barriers to whichever line theme you choose in the view. 

 

-Spline Method 
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-Fits a curve through the points surrounding the cell being analyzed and gives the cell the 

value of the curve at that location. 

-Dialog box options 

-Type - The type of curve fitting. Type can be 

- Regularized - Creates a smoother flowing surface. 

- Tension - Results in a more rough surface that tightly conforms to the input data points. 

-Weight - Controls the tautness of the curves. As the Weight increases with the Regularized 

Type, the output surface will become increasingly smoother. With the Tension Type, 

increasing the Weight will cause the surface to become stiffer, eventually conforming closely 

to the input points. 

-No. of Points - The number of nearest points around the cell being analyzed that will be 

used to fit the curve. 

 

4. Saving Grids.  Once the interpolation of the grid is done, the 

grid is shown in the view.  The amount of colors as well as the 

range and colors can be changed by double clicking the grid in 

the legend.  Playing with this can be fun and very useful later.  

The grid is temporarily saved as a surface grid.  To save this 

permanently, first find where it is to be saved.  To do this select 

“Properties” under the “Theme” menu.  In this pop up window 

the directory for the grid is shown.  Next, while a view is active, 

select “Manage Data Sources …” under the “File” menu.  Go to 

the directory that the grid is to be saved as and select “Grid” in 

the “Source Types:” drop down.  Highlight the grid and press the 

“Copy” button.  Select a directory that is convenient and a name 

that describes the grid and press “OK”.  Then press “Cancel” if 

this is the only grid that is to be copied. 
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RECIPE 14: WORKING WITH AVRAS (ARCVIEW/RAS INTERFACE) 

By Nan Shi, Last Modification: 01/27/98 

Modified by David Beekman, 08/22/00 

AVRas is an ArcView interface to RAS (HEC-RAS, River Analysis 

System, developed by Hydrological Engineering Center). The 

objective of AVRas is to show the inundation area in the ArcView 

after the hydraulic analysis is finished in HEC-RAS. This recipe is 

to show users how to work with AVRas, including the preparation 

of GIS data, using the AVRas Preprocessing to obtain input 

geometric file (*.geo) for HEC-RAS, performing hydraulic analysis 

in HEC-RAS, getting output file (*.gis) from HEC-Ras, and using 

AVRas Post-processing to delineate the floodplain. 

 

Ingredients: 

1. ArcView 

2. AVRas 

3. HEC-RAS 

4. 1: 24,000 / 1: 100,000 DLG data, it is used for creating terrain TIN 

(triangulated irregular network) for the watershed, or for the study area. 

 

Steps: 
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AVRas is a convenient extension for ArcView GIS. Prepare spatial 

information (spatial data) carefully for the preprocessing part by 

the following steps. Then, it should be easy to work it out!  

      Before you get a start, make sure that you can do the following: 

a. familiar with working with dlg data, or any other type of data you want to use, 

in the ArcView GIS 

b. know how to create new themes (point, polyline and polygon) in the ArcView, 

including edit the table which is related to the created theme 

c. know how to perform “digitizing” in the ArcView 

d. know how to import text file(*.txt) or dbase file (*.dbf) into an ArcView shape 

file 

e. know how to create a terrain TIN by using topographical data 

 

Now, let’s start! 

1. Prepare the following ArcView themes for the spatial information of a 

river:  

•  Centerline theme (line theme of the river channel):  This is used for the 

determination of stations, and stream and reach names.  The lines should 

be digitized starting from upstream to downstream (the "FROM" node is 

upstream of the "TO" node).  Each reach is defined by a single polyline.  

Make sure that the polylines are snapped at end nodes.  The stream item 

(Stream_ID) should contain the stream identifier, while the reach item 

(Reach_ID) should contain the unique reach identifier.  Outlet reach for 

each stream needs to have its "is_Outlet" value set to 1 (numeric). 
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Notes: all the items, such as "FROM" node, "TO" node, "Stream_ID", 

"Reach_ID", and "is_Outlet", should be added as new fields in the table of 

the centerline theme. 

• Cross-sections theme:  One polyline for each cross-section.  Digitizing 

should be performed consistently from left to right bank (facing 

downstream).  If cross-sections are not available for digitizing, they must 

be created using HEC 2 data.  The cross-sections should be created in 

ArcView based on parameters found in the HEC 2 data such as length 

between adjacent cross-sections, width of cross-sections, and elevations.  

Be sure the cross-sections are created from left to right bank (facing 

downstream). 

• Stream banks theme:  Used to calculate bank locations at cross-sections. 

• Flow path theme:  Used to calculate the downstream reach length for 

HEC-RAS input.  The lines should be digitized starting from upstream to 

downstream.  Each flow line needs to have its "LineType" set as l, r, or m 

(indicating left, right, or main flow path). Also, you need to add the 

LineType fields and records to the table of the flow path line theme. 

Notes: to save time, you can combine stream banks theme and centerline 

theme together to make a theme for flow path lines 

 

2. Prepare a terrain Tin 

 

To prepare a terrain tin in the watershed, topographical data can be obtained 

and used, for instance, 1:100,000 dlg, 1:24,000 dlg, DEM data, recent survey 

data of the river, the datum of gage station, etc. 
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For any type of the dlg data, topography information can be obtained in 

different detail or resolution. However, all of those data couldn’t offer 

information about the river bed topography. Thus, when you are trying to 

make a tin for the whole terrain, you may need to combine dlg data with some 

other information inside the main channel. This information can be surveyed 

data, or approximately interpolated elevations along the river centerline 

according to the general slope. If you don’t know how to make a tin, you may 

find and learn these from other recipes later on. 

 

 

 

3. Use AVààRas to perform AV/Ras pre-processing 

 

When you finish the steps 1 and 2, you are ready to perform AV/Ras pre-

processing functions. The AVàRas functions are used to generate a *.geo 
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import  

 

file for HEC-RAS. The information offered by the import file is mostly the 

geometric information of streams, including cross-sections, centerline, bank 

stations, etc. 

From the main menu bar of Arc/View, select the AVàRas option, then click on 

the Theme Setup. A window will pop-up as the above figure to let user to 

input or select the theme names for tin, cross-sections, flowlines, and banks. 

You also need to fill in a file name (*.geo) for the RAS GIS import file. You 

may not have 3D cross-section and 3D stream centerline themes ready at this 

point. This step will be finished later by AVàRas. 
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Now, you need to go to the AVàRAS menu again, finish each step by clicking 

on the options in chronological order. This includes Centerline Topology, 

Centerline Z Extract, Basic CS Attributing, Station CS Attributing, Bank CS 

Attributing, Distance CS Attributing, CS Z Extract. After you finish these, the 

two 3D themes mentioned above should be generated automatically. You need 

to check the theme setup again. Then, perform the Header Export, Centerline 

Export, and CS Export (cross-sections). Now, the import file is generated.  If a 

problem is experienced, check the options under GeoRAS_Util from the menu 

bar. 

 

4. Import the geometry file generated by step 3 to HEC-RAS, and perform 

the hydraulic computation (Suppose you are familiar with HEC-RAS 

already) 
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 After the geometry file (*.geo) is imported into HEC-RAS, you can see 

every cross-section. You may need to delete some unnecessary data points, if 

you get more than 500 points of data for one cross-section. HEC-RAS can’t 

deal with more than 500 points on one cross-section. 

In order to perform the hydraulic computation, Manning’s n values and 

friction and expansion coefficients for each cross-section should be assigned. 

Discharge data and boundary conditions should be input. 

 The .geo file will need to be opened as a separate project from the original 

HEC 2 data project.  The cross-section data, streamflow data, and Manning’s n 

values must be copied from the Original project to the .geo project.  The can be 

accomplished by using ctrl-c and ctrl-v to copy and paste. 

 Next, you may add some other structures, such as bridge, weir, and 

culvert. All of these can be done in HEC-RAS.  

 After the computation is finished, under the File option in the main menu, 

an export file with an extension *.gis can be generated. It is composed of river 

geometry information and water surface elevation. This file can be used by 

AV/Ras to make a water surface tin. This water surface tin will be used to 

compare with the former terrain tin to delineate the floodplain. 

 Before creating this water surface tin, cross-section and point themes must 

be created in ArcView using the script GeoRasConverter.ave.  This script 

creates ArcView themes based on the HEC-RAS geometry data.  The tin can 

then be generated from this point theme. 

 

5. AV/Ras post-processing and floodplain delineation 

 



 57

Comparing with the pre-processing part of the AV/Ras, the post-processing is 

easier to be used. You don’t need to do other preparations. Open your project 

in Arc/View and make sure the AV/Ras extension has already been loaded. Go 

to the main menu bar and click on the RasàAV option. Then, select theme 

setup. A RAS post-processing window should pop-up as follows: 

         According to the dialog window, the names of RAS-GIS export files and 

terrain tin need to be selected correctly.  The RAS-GIS file is the .gis file and 

the terrain tin is the previously created water surface tine.  Then, you need to 

give an output directory such as fppf_3 (for a case like the 100-year flood 

elevation). A cell size value is to be assigned. You may start from 10 map units. 

If it’s too small, you need to adjust it, and try several times. 

        After you fill in all the information, click on OK, and following the proper 

instructions. The water surface tin and the floodplain should be obtained and 

displayed automatically in a new view.  Then execute the remaining 
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commands CS/BP Generation, WS TIN Generation, and Floodplain 

Delineation in chronological order. 
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RECIPE 15: WORKING ON A WHOLE BASIN BY USING AVRAS 

 

By Nan Shi, Last Modification: 01/23/98 

 

In order to know the inundation area along the river from the most 

upstream to the most downstream, you may need a bunch of data 

including topographical information of the studied basin, main 

channel and its tributary distribution information (hydrographical 

data), and the river geometry information. If these data are 

available, it makes possible to plot the floodplain by using ArcView, 

HEC-RAS, and AVRas interface.  

 

The topographical and hydrographical data can be downloaded from 

some GIS data support center. Then, the essential issue here is that 

how to get the river geometry data. "Survey data?" Of course, if you 

can find out the survey data along the main channel, you should use 

it. But this kind of information is generally not easy to find out. Or, 

if you have time and money, you can do this survey to... However, in 

this industrial society, you always want to find out some method to 

improve the efficiency both on your time and money. "Is there any 

other method to stay in your office with your computer and Internet 

to work it out?" Yes, read this recipe, and you will get it!   

 

Ingredients: 

1. ArcView 
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2. AVRas 

3. HEC-RAS 

4. UTMS program 

5. 1: 24,000 / 1: 100,000 DLG data 

-- Topography. This data is used for creating terrain TIN (triangulated 

irregular network) for the watershed, or for the study area 

-- Hydrography. This data is used for you to know the river shape and digitize 

the stream. 

6.   The gage stations along the river and the datum of the gage 

      -- It's used to interpolate a centerline for the stream 

  

Steps: 

1. Downloading the 1: 24,000 dlg data quads in the basin and run script 

"dlg2shp" in ArcView GIS to get the themes 

-- This may cause some problem such as the quads are not well matched with each 

other. You may have to adjust all the quads to let them match well. Although I 

write a script to solve this problem, sometimes it can not be used. Because the 

1:24,000 dlg data is new, and for some reason, the identification on the 4tics of the 

quad is not follow the same standard. 

 

2. Digitizing the main stream according to the position of the stream on the 

1:24,000 hydrographical dlg data themes 
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-- You need to digitize two banks, and one centerline. Follow the rule that 

digitizing from the upstream to downstream. Make one theme for the banks, and 

another theme for the centerline. When you finish digitizing one bank, you'd 

better save it before you start to digitize the second bank. 

 

3. Preparing a line theme in the with all the cross-sections you want to 

have along the stream 

-- The cross-sections should be drawn from left bank to right bank of the stream 

(facing downstream). Draw one line for one cross-section. 

 

4. Finding out the available gage stations, with the information of the 

location (lat. and long.), and the datum of the gage (elevation above sea 

level) 

-- You may need to run UTMS to get the UTM coordinates in meters 

 

5. Run a script, to change the centerline theme to point theme (find the 

approximate position of gages) 

6. Run a script (written by Nan Shi), to read the points' coordinates and ids 

to a dbase file (*.dbf) 

7. Open *.dbf file, created in step 6, in Excel. Using the datum of the gages 

to interpolate the elevation along the stream centerline 

8. Creat a terrain tin  
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-- Because you have a bunch of quads data in the whole basin, and it takes a lot of 

memory. You may need to change topographical lines to points, then delete the 

points you don't need. 

-- Combine the topographical data and interpolated centerline's point data to 

create a tin.  

9. Run AVRas preprocessing, HEC-RAS and AVRas postprocessing 

-- Refer to the Recipe 1. Steps omit here. 

 

Notes: The information in this recipe let you know the general steps for working on 

the entire basin. For any questions, please either contacts Nan Shi or my advisor 

Dr. Tiao J. Chang. Thanks. 
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RECIPE 16: A SIMPLE DIGITIZING RECIPE 

 
Description: This is a recipe to teach you how to digitize a map by using the ADS 
program in ARC/INFO, and how to export the digitized coverages. Of course, there 
are still some other methods in ARC/INFO to perform digitizing, such as 
ARC/EDIT. However, it's not in the scope of this recipe. 
 

Steps: include steps for digitizing, transforming and exporting 
 
Step 1: Digitizing 
 
1. Arc: &station dig 
 
2. Arc: ads <coverage_name>  (e.g. “quad17”) 
 
3. Now we are in the ADS program. We are ready to digitize the ticks. The 

screen looks like this: (from now on only the cursor works, the keyboard 
doesn’t work) 
 
Tic ID:  
 

4. Use the cursor to insert 4 tics this way: 
1A1 - 1st tic 
2A2 – 2nd tic 
3A3 – 3rd tic 
4A4 – 4th tic 
The screen will be like this: 
Tic ID: 1* 
Tic ID: 2* 
Tic ID: 3* 
Tic ID: 4* 
 

5. Finish inserting the tics by hitting “0A”. 
 
6. The program then asks you to enter the boundary. We enter the boundary by 

defining the locations of the lower left corner and upper right corner: 
- Locate the lower left corner of the map by clicking “1” on the cursor; 
- Locate the upper right corner of the map by clicking “2” on the cursor. 
 

7. The screen displays the message  
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8. Once finished, the digitizing menu pops up like this: 
1) Add Arcs     3)Add labels  5) Draw coverage   7)Add Tics 
2) Remove Arcs  4)Remove labels 6)Define windows  8)set options           
9) Exit     Enter functions: 
 
9. Begin adding arcs by hitting “1” (Add Arcs), then we’re ready to digitize arcs 
one by one. Starting the first node by hitting “2” , input the following vertices 
by hitting “1” and finish the arc by entering “2”. 
The style looks like this:    

 
    1  
           1 
                          2 
2 
 

10.  When you’re digitizing, the following appears on the screen: 
<Vertex#>  1# of coordinates = 0 
<Vertex#>  2# of coordinates = 0 
... 
... 
 

11. Exit ADS program by entering “9”, before you actually exit the program, 
remember  save the file following the instructions on the screen. 
 
 
12. Remember use the text editor to create a tic coordinates table like this. 

Tic-ID  x(longitude)  y(latitude) 
1  -83.00   43.792 
2  -83.00   43.65 

 

STEP 2: TRANSFORMING 
 

1. Now we’ll project tics from digitizer units to real-world coordinates. Firstly 
create a new coverage which is a copy of an existing coverage only with the 
TIC and BND files. 
Arc: create <new_cover> <original cover>  (e.g. Arc: create 
quad17_real quad17) 
 

2. Update the TIC file in INFO with the real-world coordinates. Do the 
following: 
Arc: info  
The INFO program starts. Using caption letters for all entries. 
ENTER USER NAME: Arc 
ENTER COMMAND: SELECT <new_cover_ticfile>   
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(e.g. SELECT  QUAD17_REAL.TIC) 
ENTER COMMAND: UPDATE 
$RECNO?>1  (enter “1” to update the 1st tic) 

      ?>XTIC = -83.00  (“-“ is needed) 
     ?>YTIC = 43.792 
     ?> 
     $RECNO?>2…..    (the rest will be done in the same pattern) 
3.  Finish UPDATE by hitting a carriage return, go back to ARC 
by typing as below: 

ENTER COMMAND: Q STOP 
4. Now transform the whole coverage into the real-world coordinates by the 

following command: 
Arc: transform <original cover> <real-world cover> 

     (e.g. Arc: transform  quad17  quad17_real) 
   

step 3: Exporting 
 
1. Clean the attribute table by typing in the command below: 

Arc: clean <in_cover> <out_cover> 0 –1 line 
(e.g. Arc: clean quad17_real  quad17a 0 –1 line) 

 
2. Export Arc file to a new shape file. 

Arc: arcshape <real-world cover> <feature_class> <output_shapefile_prefix> 
(e.g. Arc: arcshape  quad17a  arcs  quad17) 
The output shapefile will include three files of the following type: 
*.dbf, *.shp, and *.shx 
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Recipe 17:  Downloading and Converting 1:24,000 Optional and 

Standard Format DLGs 

In order to execute many of the recipes in this cookbook, it is 

necessary to obtain a desired DLG.  These DLGs can be downloaded 

from the Ohio DAS ftp site with no charges.  This recipe presents a 

step by step format to effectively download and convert 1:24,000 

DLGs to shape files. 

Ingredients: 

Arcview 

Internet Browser (i.e. Internet Explorer) 

WinZip 

Dlg2shp.ave avenue script 

Steps:  

1. Open the Ohio DAS ftp site with an Internet Browser.  The 

web address is ftp.geodata.gis.state.oh.us.  The web address is 

www.geodata.state.oh.us. 

2. Enter the folders geodata, dlg, and 24000 in order.  Open 

24k_idx.pdf to view and determine the location of the quads 

that are needed. 

3. Return to the 24000 folder. 
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4. Open the status folder and then open the dec2398.txt folder to 

determine the directory and prefix name of the quad(s) 

needed. 

5. Return to the 24000 folder 

6. Open the data folder and the folder in which the quads are 

located from the dec2398.txt file 

7. Select the quad with the desired prefix.  There will be seven 

files with this prefix.  The files are for boundaries, 

hypsography, hydrography, miscellaneous transportation, 

roads, railroads, and public land data. 

8. Download the selected files by clicking or double clicking on 

the desired filename. 

9. Open up the Windows Explorer.  Go to the location in which 

the files were saved. 

10. Double click the *.zip file to open the file.  Drag the *.dlg file 

from the WinZip window to the desired folder in the Windows 

Explorer window. 

11. In ArcView, open a new script window by selecting the script 

tab from the project window and click the new button. 

12. From the Script menu select Load Text File… 

13. Find dlg2shpe.ave.  Compile this avenue script by clicking on 

the check mark button. 

14. Run the script by clicking on the running guy button. 
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15. In the box, select the folder and the dlg(s) to convert to 

shapefiles. 

16. If multiples are selected add the shapefile theme from the 

folder into a view.  The most perfered shapefile will be the 

*_line.shp. 

17. If a single dlg is converted follow the directions from the 

script. 
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Appendix A:  ArcView Nomenclature 

Some Windows Basics 

The commands a user gives to ArcView are found on the “Menu bar” 

and “Tool bars” at the top of the ArcView screen.  The menu bar and 

tool bars are probably familiar to most Windows users.  The menu 

bar is a list of words such as “File,” “Edit,” “View” and “Theme” 

stretching across the top of the ArcView window on the computer 

screen.  When any of the words on the menu bar are clicked with 

the mouse, a pull-down menu appears giving a set of commands that 

can be performed.  The tool bars are the two rows of buttons that 

appear below the menu bar.  Menu bars, tool bars and title bars are 

all identified below on Figure A.1. 

Every Window has a “title bar” running across its top.  At the left 

and right ends of the title bar are the buttons used to close, 

minimize and maximize the window.  The title bar tells whether a 

window is “active.”  When a window is active, the color of the title 

bar is different from the color of other title bars.  Typically, the title 

bar of an active window is blue, while that of inactive windows is 

gray.  The title bar both gives the title of the window and also 

provides a convenient means for moving the window around.  To 

move a window, click on the words at the center of the title bar and 

don’t let up the mouse.  Next, move around the mouse to relocate 

the window. 
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Figure A.1:  ArcView Desktop 

 

ArcView Projects 

When a user starts ArcView, the ArcView window appears on the 

screen.  The window has a menu bar, two tool bars and a big empty 

space below the tool bars.  Numerous other windows can be opened 

in the empty space.  The first window opened in that space always 

is the “Project Window.”  This window is a sort of project accountant 

which keeps track of all the different files and jobs associated with 

the project.  To get the project window onto the screen, go to the 

menu bar and select either “New Project” or “Open Project” from 

the “File” pull-down menu.  If the “New Project” command was 

selected, the project window appears alone in the empty space.   
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There are five entities in ArcView: Views, Tables, Layouts, Charts 

and Script  These are the five different products ArcView can 

generate.  A view is a working version of a map.  Tables and charts 

are tables and charts of the data.  The author commends the 

sensible choice of these names.  A layout is a prettied-up picture of 

a view or chart, complete with text, scale bar, North arrow or any 

other fancy graphic intended to score extra credit.  Scripts are 

programs written specifically for ArcView. Many scripts are 

available in ArcView distribution files and over the internet.   

An ArcView project can be comprised of multiple views, tables, 

charts, layouts and scripts.  To make a new, blank one of any of 

these products, click on the icon associated with the desired one (on 

the left side of the project window) and click the “New” button at 

the top of the project window. 

As shown in Figure A.2, a view window has two parts: the view 

(map) itself and a legend.   
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Figure A.2:  A View Window 

The legend is a column on the left side of the view window and 

contains information about all the data that are shown in the view.  

The data are arranged into “themes” such as political boundaries, 

roads, rivers, micro-brewery locations, etc.  By clicking on boxes 

found in the legend of a view, the various features can be turned off 

and on.  Double clicking on the various entries in the legend enables 

the user to edit the way the theme is displayed.  The user can 

change display features such as color, font, line thickness, marker 

size, fill and other features. 
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Appendix B:  The UTMS Program 

The UTMS program is a DOS program written by USGS personnel 

and freely available on the WWW.  It is simple to run.  simply 

change directories to the directory where UTMS.EXE is located and 

type “UTMS” at the DOS prompt.  Using the directory structure 

given in this report, type 

C:\> cd GIS 

C:\GIS> cd Utilities 

C:\GIS\UTITLITIES> UTMS 

then follow the on-screen instructions.  The output from UTMS 

should be directed to a file.  The output file will be ASCII format 

and can be converted to a dBase (.dbf) file using Microsoft Excel or 

any other spreadsheet program. 
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Appendix C:  Getting data into Arcview 

ArcView is delivered with fairly detailed data of the United States’ 

political boundaries, roads, waterways and zip code zones, as well 

as a coarse coverage of the world’s political boundaries and rivers.  

These data are a good jumping-in place, since finding data and 

getting it into ArcView can be a struggle. There are also a lot of 

detailed, free data available on the Internet and from other sources 

that can be readily used in ArcView. In this report, an outside (and 

free!) data source is used and the steps to get the data into ArcView 

are explained.  Two excellent sources of data are the US 

government and the UN.  Both organizations have a lot of detailed 

data available on the Internet.   

The two types of data files easiest to use in ArcView (other than 

files made specifically for ArcView) are USGS DLGs (US Geologic 

Survey Digital Line Graphs) and ARC/Info Export files.  How to get 

each of these file types into ArcView’s format is described below. 

USGS Digital Line Graphs 

USGS DLGs can be found at the world wide web site: 

http://usgs.gov/.... 

The files can be downloaded in either “standard” or “optional” 

format.  The following steps use the “optional” format.  Following 

links on the web page given above leads to a map of the United 

States.  On this map, click (with the mouse) on the approximate 

region of the country where the DLG data are desired.  A second 

map pops onto the screen showing rectangles with names.  The 

USGS has divided the country into rectangles, each one 1º H  1º.  The 

rectangles are further divided into sectors, as shown in the figure 
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below.  Clicking on the rectangle where the data are desired leads 

to a pages from which the desired data can be downloaded.  When 

downloading USGS DLGs, the sectors are downloaded one at a 

time.  Several types of DLGs are available for downloading, 

including political boundaries, hydrography, hypsography (elevation 

contours) and transportation (both road and rail).  The boundary 

files are fairly small, but all the others are quite large and may not 

fit on a floppy disk. 

 

1 2 3 4 

5 6 7 8 

   West           East 

 

Figure 1:  USGS DLG Sector Numbering Scheme 

 

To make life easier, the author of this report gives such as: 

parb1.opt.gz 

to files downloaded from the USGS DLG site.  In the above nape, 

the “par” is an abbreviation for the name of the sector for which the 

DLG was downloaded (in this case, the first three letters of 

Parkersburg).  The “b” refers to the DLG type; b stands for 

boundary, h stands for hydrography, r stands for roads, rr stands 

for railroads and y stands for hypsography.  The “1” refers to the 

sector number, as shown in Figure 1.  The “opt” denotes that the 
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DLG is in optional format and the “gz” is used because the file has 

been compressed using the gnuzip utility and must be unzipped 

with a program that can handle files compressed with gnuzip.   

The files that are downloaded from the USGS are compressed 

(“zipped”) and are simply long streams of data without distinct 

lines.  The popular Windows program Winzip can unzip files that 

are compressed in gnuzip format. Winzip produces an 

uncompressed file whose name should be something like: 

parb1.opt 

Once the DLG files are uncompressed, they have to be converted to 

files with line lengths of 80 characters per line. The USGS has 

available on one of its web sites a program called chop to 

accomplish this task.  The chop utility can be downloaded at the 

ever-popular cost of $0.00.   To “chop” a file using the chop program, 

go to a DOS prompt and type the following line: 

 chop 80 < parb1.opt > parb1.dlg 

Note that this command must be issued in the same directory where 

both the program chop and the file parb1.opt are found.  

Otherwise, a path must be supplied along with the file names for 

the files parb1.opt and parb1.dlg. 

A mere single step remains before the data can be used in ArcView: 

using an Avenue script to create a “shape file” as used by ArcView.  

Briefly, a script is a list of commands (like a program) that “do 

something” in ArcView.  Avenue is the name of the programming 

language used in a script.  In general, other people really fond of 

ArcView write scripts and the rest of us use them.  Such is the case 

with the script DLS2SHP.  DLG2SHP was written by someone at 

ESRI, the company that sells ArcView.  It takes the DLG file 



 77

created in the preceding steps and produces ArcView data.  The 

copy used in the Water Resources Group in the OU Civil 

Engineering Department was downloaded from ESRI’s web site.  

Scripts are run inside of ArcView.  To run the script, make sure to 

know where (which directory on the computer) the script is located.  

Start ArcView and create a new project (as described above).  From 

the “project” window, click on the Script icon.  Next, from the menu 

above, select “Load Text.”  Selecting “Load Text” makes a window 

appear.  In that window, go to the appropriate directory and click 

on the file dlg2shp.  Hit the “OK” button and ArcView loads the text 

file containing the script.  Next, the script is compiled.  To compile 

the script, select “Compile” from the “Script” pull-down menu.  

Finally, run the script.  To run the script, be sure the “Script” icon is 

active in the project menu.  Click on the “Run” button at the top of 

the projects window and enter the file name and path of the DLG 

being converted.   

ARC/Info Export files 

Making ARC/Info Export files into ArcView files is considerably 

easier than converting USGS optional format DLGs.   

One source of ARC/Info Export files is the world wide web page  

 http://erdas... 

This page contains political boundaries, populations, land use, 

climate zones and soil types of Asian countries.  The data were 

compiled by the USGS and UNEP (UN Environmental Programme).  

Data from this source were used in the preceding demonstration.  

Inmost cases, the ARC/Info export files are compressed and must be 

“unzipped” before being converted. 
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To import ARC/Info export files, use the ArcView Import utility.  In 

Windows 95, the Import 71 utility can be found in the “Start 

Programs” menu, underneath the entry for ArcView.  Simply start 

the Import 71 program and follow the directions.  In the upper box, 

enter the path and file name for the export file (the file you want to 

convert).  In the lower box, enter the directory in which the 

converted files should be placed.    
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Appendix D:  GeoEAS 

Following is a step-by-step example demonstrating Kriging with 

GeoEAS.  The example demonstrates all the steps normally 

performed in Kriging, but does not use all of GeoEAS’s functions.  

The particular example presented below is the Kriging of stream 

flow data for stream flow gaging stations in the basin.  

The steps involved in the process are: 

• creation of a new data file; 

• preprocessing of the data file to create a “pairs file;” 

• plotting of a variogram and fitting a model to it; 

• Kriging of the data; and 

• checking the validity of the Kriged estimates. 

Before starting, here are some hints for using GeoEAS.  First, to 

exit any screen or function you want to get out of, tpye the “q” key.  

Other control sequences (such as escape) will not work.  Second, 

each GeoEAS project uses several files.  It is strongly urged that 

each GeoEAS user creates a separate directly and keeps all his/her 

files in that directory. The files required in each project are: 

• file.dat (an ASCII file containing gaging locations and data); 

• file.pcf (a pairs comparison file generated by GeoEAS); and 

• file.grd (the GeoEAS output file of Kriged data). 

In addition to these three files, the user can create a Kriging 

parameters file.  Since this is not essential, it is not described in 

this Appendix.  For all the files above, , file should be replaced with 
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a descriptive name (such as stream) preferably with 6 characters or 

fewer in the name. 

Finally, all the operations you perform are selected from menus 

running across the bottom of the GeoEAS window. The first thing 

you need to do in a GeoEAS function is to set the working directory 

to the one where your data are located.  To do this, select “Prefix” 

from the menu at the bottom of the screen and type the correct 

path, FOLLOWED BY A \.    Otherwise, the program will not be 

able to find your data. 

Creating and Viewing a Data File 

A GeoEAS data file (input file) contains measurement locations 

(Eastings and Northings) and the data associated with those 

locations (e.g., precipitation, temperature, wind velocity).  In 

addition to data, labels for axes and units for data values are 

included in the input file.  The format of the input data is import.  

Some of the input lines to GeoEAS are “fixed format” and the 

number of blanks between the numbers and characters is important.  

Because of this, it is best to use the DOS editor to create data files 

for GeoEAS. 

The input file you need for this lesson is given in Table D.1.  Use the 

DOS editor to type it in, exactly as it is shown below and save it 

with the name “stream.dat.”.   Notice that there are three columns 

of data: the Easting (in meters) of a drainage centroid, the Northing 

(in meters) of the drainage centroid and the stream flow water 

equivalent depth (in inches) associated with the centroid. 

The lines of this data file are described in detail on the following 

page. 
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Table D.1:  GeoEAS Input 

Mean Annual Flow in Water Equivalent Depth               
3                
Easting   m 
Northing  m               
Stream    in 
293230.83       4495743.98      10.819 
294813.20       4465663.28      12.095 
293357.85       4481828.54      11.051 
343200.56       4505356.15      13.609 
338474.59       4493189.60      12.210 
303676.23       4468760.69      11.654 
345487.27       4464596.05      13.832 
337719.53       4469377.35      13.396 
332356.45       4456205.55      13.244 
341694.95       4450812.25      11.883 
297863.70       4432063.65      11.818 
294875.55       4407139.09      13.197 
299298.24       4407301.56      13.265 
313949.13       4436461.27      12.137 
282160.89       4381296.67      13.739 
282022.62       4343847.01      14.883 
291002.61       4375571.65      13.645 
313949.13       4425297.57      12.134 

 
 
Line 1 - Title 

This line is a descriptive title which may contain up to 80 

characters.  Most of the programs in GeoEAS display this 

title on the screen in graphics screens.   

Line 2 - Number of Variables (NVAR) 

This line tells the program how many columns of data there 

are in the data file.  The minimum number of columns is 3, as 

in the example input file.  The limit to NVAR is 48 and the 

limit to the number of measurement locations is 1000. 

Line 3 → NVAR + 2 

The next several lines tell what the names are for the x- and 

y-axes and the parameter that is being Kriged.  There is one 
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line for each variable.  The first ten characters give the 

parameter name and characters 11-20 give the units. 
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Line NVAR + 3 → the end of the data file: columns of data 

Columns represent the different variables and the row 

represent measurement locations.  The data may be in “free 

format,” which means that in a given line, variables must be 

separated by at least one blank or a comma. 

Starting GeoEAS and preprocessing your data 

Once the data are properly entered, begin GeoEAS by changing 

directories to the GeoEAS directory and typing “GEOEAS” (in DOS) 

or double-clicking the GeoEAS.EXE icon (from the Windows 

Explorer in Windows ’95).  The main menu for GeoEAS should 

appear.  You now see the various programs that make up GeoEAS.  

They include: 

• VARIO (for generating variograms) 

• KRIGE (for Kriging) 

• POSTPLOT (for viewing the data locations) 

• XVALID (for cross-validating your variogram model) 

• PREVAR (for generating a “pairs file”) 

and others.  Use the cursor keys to highlight “Prevar” and hit enter. 

Look at the menu at the bottom of the screen.  First, you need to 

specify the directory where your data file is located.  To do that, 

cursor to the “Prefix” entry in the menu and hit enter.  Specify the 

correct directory at the top of the window.  It should look something 

like C:\GIS\GEOEAS\YOURNAME\ 

Once the directory is specified, select “Data” from the menu and 

type the name of your data file (Stream.dat).  Your data should load 
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now and you will be prompted to give the data for the x-axis, y-axis 

and variable.  Choose Easting, Northing and Stream, respectively.  

Once the variables are properly specified, select “Execute” from the 

menu.  Prevar creates a “pairs comparison file” called stream.pcf 

and returns you to the main menu.   

Examine your Data 

To make sure that the data you got are the data you want, you 

should use the programs “STAT1” and “POSTPLOT” to generate 

basic statistics about your data and to view the data locations.  

These routines are straight-forward and are not described here.   

Generate and Model a Variogram 

From the main menu, select “Vario.”  As usual, make sure the prefix 

is correct and specify the file “Stream.pcf” as your data file.  Once 

the data are specified, select “Option/Execute” and a new window 

appears.  For this example, omni-directional Kriging is used and no 

changes are made in the direction field.  Next, select a lag spacing.  

This is a trial and error process.  (See the flow chart at the end of 

this Appendix).  For now, simply use the default lag spacing.  Select 

“Execute” and VARIO calculates the variogram.   

A new window appears with the options “Plot” and “Model” at the 

bottom of the screen.  First, plot the variogram you just created.  

Cursor to “Plot” and hit enter.  The variogram appears on your 

screen.  Take note of the shape because later you will need to 

estimate a sill and range.  To exit this screen, hit the “q” key.  Next, 

choose the variogram model by selecting “Model” from the menu at 

the bottom of the screen.  Enter the Nugget, Model Sill and Range 

you want.  To specify the model, tap the space bar until the model 

you want appears.  When you have entered the model you want, hit 
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“Enter” until you are back in the menu at the bottom of the screen.  

Select “Plot” to see how well you did in choosing the variogram 

model.  It will likely take you several tries before your model 

matches your variogram.  If there is no trend apparent in the 

variogram, increase the lag spacing.  Once you are satisfied with the 

model, write down the parameters and quit to the GeoEAS main 

menu. 

Cross Validate Your Model 

Select “XVALID” from the main menu to enter the cross-validation 

routine.  

Kriging the Data 

Select “KRIGE” from the GeoEAS main menu.  If the prefix is 

correct in the window that appears, select “Options/Execute.” 

Specify your data file (stream.dat) and give the output file the name 

stream.grd.  The Kriging tpye should by “Ordinary” and “Point.”  

For now, accept the default grid values by selecting “Grid” from the 

menu at the bottom of the screen and hitting “enter” until you are 

back at the menu.  KRIGE choosing values for the minimum Easting 

and Northing and grid spacing.  Later you should change these to 

values that encompass the entire Scioto Basin.   

Specify search parameters.  Again, use the default values for now.  

Select “Model” from the menu and enter the model parameters 

corresponding to the variogram you generated in a step above.  

When the model is properly entered, quit to the previous screen 

and select “Execute.”  A Kriging image should appear on your 

screen.  If the program was unable to get a value for a grid point, a 

white X appears at that grid point.  This indicates that you need a 

larger search radius or you should choose a smaller number of 
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minimum points in the search.  Continue trying to Krige until all 

the grid points are filled.  Congratulations.  You have successfully 

Kriged and your output file “Stream.grd” is ready to be put into a 

GIS. 


